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About this publication

This publication provides installation and configuration information about
Manufacturing Optimization. Manufacturing Optimization is a feature of InfoPrint®

ProcessDirector.

Who should read this publication
This publication is for system administrators who need to install and configure
Manufacturing Optimization.

Related information
Visit the InfoPrint Solutions Company Web site to see the most recent version of
this documentation, and to find documentation for related products:

http://www.infoprint.com/infocenter
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Chapter 1. Manufacturing Optimization

Manufacturing Optimization expands the concept of a print workflow beyond
controlling and tracking print jobs to encompass controlling and tracking
individual documents in a print job. You can pull documents out of a workflow or
reprint individual documents. Without changing the application that creates the
print job, you can change the way the individual documents are processed, using
business rules to indicate what processing to do. The documents in the print job
can be split into subset print jobs, sorted based on document-specific information
like address data, or grouped into subset print jobs based on data in the document.

Terms
These terms are associated with Manufacturing Optimization. You can find more
detailed information about each term in other topics.

Document
The smallest unit in a job that can be tracked by a workflow; for example,
a document might be a set of pages that make up one bill, one statement,
or one mailpiece. Manufacturing Optimization uses properties of the
document, such as Customer Name, to distinguish one document from
another in a job.

Documents portlet
A portlet on the Main page of the user interface. The Documents portlet
contains the Documents table, where you can display a list of individual
documents and see their properties. You can also create a job containing
the documents that you select.

Document database
A repository that can manage the individual documents in the system.

Document properties file
A file that can contain properties of documents in a job; the file is stored in
the job’s spool directory. The document properties file is created
automatically by the step templates IdentifyDocuments,
ReadDocumentsFromDatabase, CreateJobsFromDocuments, and
CreateAFPJobsFromDocuments. The file is structured like a table; the first
line identifies the properties that are in the file, and each additional line
contains the property values for each document. InfoPrint ProcessDirector
uses the information in the document properties file to keep track of the
documents associated with each job.

Important: Never edit this file manually.

Original job
The job that carries a document into InfoPrint ProcessDirector. Usually, its
job type is associated with an input device that receives files from an
external source. The job type then processes the file to identify documents
and their properties, and optionally loads the data into the document
database.

Production job
A job that is created from documents.
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Assemble phase
A phase that can be defined in a workflow. The Assemble phase contains
steps that organize documents prior to phases such as Print and Insert that
produce the physical documents.

Document properties configuration file
A file that defines the custom document properties and job properties to
use for job sorting, splitting, and grouping. You work with your support
representative to set up this file during the configuration process. This file
is named docCustomDefinitions.xml; it identifies which custom document
properties are managed in the database, and which properties exist only in
the document properties file.

One docCustomDefinitions.xml file exists for the entire system.

Document properties names file
A file that defines caption information for custom document properties and
for job properties, for display in the user interface. The file is named
docCustomDefinitions.properties; it is associated with the custom
document properties and job properties that you define in the
docCustomDefinitions.xml file. If you are using only one language in your
environment and you do not define any job properties in the
docCustomDefinitions.xml file, you do not need to edit the
docCustomDefinitions.properties file.

Document properties template file
A file that determines which properties go into the document properties
file for a job. The template file lets you control the number of document
properties to be used, as well as the order of the columns in the document
properties file. You can use multiple document property template files in
one InfoPrint ProcessDirector system.

Document Property Designer
An InfoPrint Visual Workbench function installed with Manufacturing
Optimization that lets you customize document properties for your
installation. Document Property Designer lets you link information in the
original job to document properties that are used by steps in the workflow
to assemble jobs from documents.
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Chapter 2. Planning for installation

Before you can install Manufacturing Optimization, you must obtain the required
hardware and install required software. You must also decide what your
requirements are for processing documents in print workflows.

Hardware requirements
Make sure that your system meets the system requirements for the InfoPrint
ProcessDirector base product and for any optional components.

The system requirements in this section replace the corresponding requirements for
the base product. The system hardware requirements for Manufacturing
Optimization are:
v One or more 2.8 GHz or faster processors.
v For Linux® and AIX® systems, a minimum of 200 GB free hard-drive space.

More space might be required, depending on the number of documents.
v On AIX 32-bit or 64-bit systems, a minimum of 12 GB RAM.
v On Linux 64-bit systems, a minimum of 12 GB RAM.

Software requirements
Make sure that your system has the required software before installing
Manufacturing Optimization. In addition to the required software described in this
section, we recommend that you use an XML editor to edit the required XML
configuration files. The installer does a schema-based validation of XML files but
does not validate all syntax.

xmllint utility
The xmllint utility is required. Manufacturing Optimization automatically uses it
during the installation process to validate your XML configuration files. If xmllint
is not on the system when you install Manufacturing Optimization, the
configuration files will not be validated, and errors might occur during activation.

Manufacturing Optimization requires version libxml2-2.6.21-3 of the xmllint utility.
Typically this utility is already installed on Linux systems, but on AIX systems you
must install it manually.

The xmllint utility is contained in the libxml2 software library, which IBM®

provides on the AIX Toolbox for Linux Applications CD. You can install the libxml2
library from the Toolbox CD or by downloading it from this Web site:
http://www-03.ibm.com/systems/p/os/aix/linux/toolbox/download.html

Follow the installation instructions in the AIX Toolbox for Linux Applications
readme file on the Web site.

IBM C++ Runtime Environment Component
Manufacturing Optimization for AIX requires the IBM C++ Runtime Environment
Component (xlC C++ Runtime, Version 8.0 or later).

© Copyright InfoPrint Solutions Company 2009 3



You can download the required package from this Web site:

http://www-01.ibm.com/support/docview.wss?rs=2030&context=SSJT9L
&uid=swg24015997&loc=en_US&cs=utf-8&lang=en

Follow the installation instructions on the Web site.

Gathering your document requirements
Determine what document properties are relevant for the workflows that you want
to create.
1. Ask yourself questions like these:
v What document properties will you use to distinguish your documents?

(What makes one document different from another?)
v What document properties do you need to identify to make use of data

defined in the index tags (also called Tagged Logical Elements (TLEs)) in
your Advanced Function Presentation™ (AFP™) file?

v What properties do you want to use as criteria for sorting or grouping
documents? For example, you could define a property called “postal code”
so that you can sort AFP documents according to postal code.

v If you have an Inserter feature, what information do you want to include in
inserter bar codes or in inserter control files? For example, to include the
document’s ZIP code in the inserter control file, you could define a
document property called “ZIP code”.

2. From your answers, decide what properties to define. Some properties that you
might want to define are:
v Address line
v Postal keyline
v Data that you want to put into a bar code that is unique for each document
v ZIP code
v Dispatch type, such as express or regular mail
v Encloser type, such as flat or fold
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Chapter 3. Installing and activating Manufacturing
Optimization

Prepare the required configuration files first, and then copy them into the required
directories before running the installation program.

Example configuration files to use as a guide are on the service update CD in the
/samples directory.

Setting the maximum number of open files (optional)
The system setting for the maximum number of open files prevents an
uncontrolled process from taking over your system, but you might need a higher
limit than the default if you are processing jobs with many documents. Changing
the open file limit lets Manufacturing Optimization use more system resources.
This task is optional, but if you have trouble with File Not Found errors appearing
in the job log during job processing, you should do this task.

To set the open file limit:
1. Log in to your system as the root user, or use the su or sudo command to

become the root user.
2. AIX: Open the file /etc/security/limits.
3. Linux: Open the file /etc/security/limits.conf.
4. Find the line in the file that sets the open file limit. For example, on a Linux

system it might look like this: aiw1 - nofile 4096. If the line does not exist,
add it in the next step.

5. Edit the line, or add a new line if needed, to set a higher limit for the aiw1
user. This example sets the limit to 15,000 on Linux: aiw1 - nofile 15000. This
example sets the limit to 15,000 on AIX: aiw1 - nofiles 15000. Check with
your system administrator to determine a reasonable upper limit for the
number of open files.

6. Log out as root and log in to make the change take effect.

Preparing configuration files before installation
Do these steps to prepare the required configuration files first, and then copy them
into the required directories before running the installation program.

These instructions assume that the InfoPrint ProcessDirector base product has
already been installed and activated. Make sure you have the correct version of
InfoPrint ProcessDirector.

Example configuration files to use as a guide are on the feature CD in the
/samples directory.

Editing the document properties configuration file
The document properties configuration file (docCustomDefinitions.xml) controls
how Manufacturing Optimization uses document properties and job properties to
manage jobs.

© Copyright InfoPrint Solutions Company 2009 5
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Notes:

v Manufacturing Optimization defines these document properties automatically.
Do not define these properties in the docCustomDefinitions.xml file:
– Doc.ID
– Doc.OriginalJobID
– Doc.OriginalSequence
– Doc.OriginalSheets
– Doc.OriginalPages
– Doc.OriginalFirstPage
– Doc.State

v The Inserter feature defines these document properties that you can customize
and include in inserter control files and bar codes. Do not define these
properties in the docCustomDefinitions.xml file:
– Doc.Insert.BinTriggers (Inserter Level II feature only)
– Doc.Insert.DivertBin
– Doc.Insert.RecipientName
– Doc.Insert.OriginalBarCode

v Define document properties for enhancing AFP, such as for bar codes, in this
file.

To edit the document properties configuration file:
1. Navigate to the /samples directory on the service update CD.
2. Copy the sample docCustomDefinitions.xml file to a working directory.
3. Edit the file as needed, using the comments in the file to identify the sections

that you want to change. We recommend using an XML editor to validate your
syntax. Keep a backup copy of the edited file for recovery purposes.

4. Take note of the location of this edited file. When you run the installation
program later, you will move the file to its proper location.

If you change the docCustomDefinitions.xml file after activating Manufacturing
Optimization, you must activate again with the new settings. Define your
requirements accurately to avoid needing to reactivate.

Editing the document properties names file

You provide descriptive information about custom document properties and job
properties in the docCustomDefinitions.properties file so that InfoPrint
ProcessDirector can display it in the user interface, such as in drop-down lists and
in messages.

Entries in the docCustomDefinitions.properties file are related to the docProperty
and jobProperty elements in the docCustomDefinitions.xml file. The
docCustomDefinitions.properties file is required to:
v Define captions for any job properties that you defined in the

docCustomDefinitions.xml file. Job property captions cannot be defined in the
docCustomDefinitions.xml file.

v Define captions, short captions, and descriptions if you are setting up more than
one language. You create a separate docCustomDefinitions_language.properties
file for each additional language.
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If all of these conditions are true, you do not need to edit the
docCustomDefinitions.properties file:
v You are using a single language (English or any other language).
v All document property descriptive text is defined in docCustomDefinitions.xml.
v You did not include any job properties in docCustomDefinitions.xml.

Note: Although in these cases you do not need to edit
docCustomDefinitions.properties, a file with the name
docCustomDefinitions.properties must exist in the /aiw/aiw1/config directory for
activation to succeed.

You define these values for each custom document property:

Name Property notebook headings in the user interface

Document field
Drop-down lists and captions in the user interface

Short name
Table column headings in the user interface, if applicable

Description
Online help when you click the help icon

For job properties, you define only the Document field element.

To edit the document properties names file:
1. Navigate to the /samples directory on the service update CD.
2. Copy the sample docCustomDefinitions.properties file to a working directory.
3. If you included any job properties in the docCustomDefinitions.xml file, edit

docCustomDefinitions.properties to add the required Document field elements.
4. For any languages other than the default language, create language-specific

docCustomDefinitions_language.properties files. For example:
v docCustomDefinitions_de.properties (German)
v docCustomDefinitions_en.properties (English)
v docCustomDefinitions_es.properties (Spanish)
v docCustomDefinitions_fr.properties (French)
v docCustomDefinitions_it.properties (Italian)
v docCustomDefinitions_ja.properties (Japanese)
v docCustomDefinitions_pt.properties (Brazilian Portuguese)
v docCustomDefinitions_ru.properties (Russian)
v docCustomDefinitions_zh.properties (Traditional Chinese)
v docCustomDefinitions_tw.properties (Simplified Chinese)

5. Edit the files as needed. Keep a backup copy of the edited file for recovery
purposes.

6. Take note of the location of this edited file. When you run the installation
program later, you will move the file to its proper location.
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Running the installation program
As with the InfoPrint ProcessDirector base product, the installation process
includes activation. You can run the activation process at the end of the installation
process, or you can install additional features before activating Manufacturing
Optimization.

Follow the appropriate steps depending on whether you are installing on an AIX
or a Linux system.

Make sure you have already edited the sample configuration files located on the
service update CD in the /samples directory before starting the installation
process.

Important: If you are using the Remote DB2 function in InfoPrint ProcessDirector,
do not activate Manufacturing Optimization at a level lower than the current PTF
version.

To install and activate Manufacturing Optimization:
1. Stop the primary server.
2. Log in as the root user.
3. AIX: Enter this command to make sure that you are in the root directory:

cd /

4. AIX: Make sure that only one session of the cdrom daemon (cdromd) is
running. Enter:
ps -ef | grep cdromd

v If there is more than one session of the daemon running, make note of the
process ID of each daemon and use the kill command to stop all except one
session.

v If there are no daemon sessions running, enter:
cdromd

5. Insert the base feature CD for Manufacturing Optimization in the CD-ROM
drive.

6. Linux: To determine the name of the CD mount point, enter:
ls /media/*

On some systems where the CD is mounted automatically, the name of the
mount point is the same as the name of the CD.

7. Linux: Mount the CD, if necessary. Enter:
mount /media/mount_point

8. Linux: Enter this command to start the installation:
/media/mount_point/setup

9. AIX: Enter this command to start the installation:
/cdrom/cd0/setup

10. Select the appropriate language for the wizard to use and then click OK. You
see a welcome window for the InstallShield Wizard.

11. Reply to any prompts as the InstallShield Wizard steps you through the
installation.

12. When the installer prompts you to select configuration files, choose to use the
default configuration files that the installer found in the /aiw/aiw1/config
directory and continue.

8 InfoPrint ProcessDirector: Installing and Configuring the Manufacturing Optimization Feature
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13. When you see a prompt to activate the installation, select Activate later and
exit the installation.

14. Copy the docCustomDefinitions.xml file and (if applicable) the
docCustomDefinitions_language.properties files that you previously edited to
the /aiw/aiw1/config/ directory.

15. Insert the service update CD into the CD-ROM drive and start the installation.
16. When the installer prompts you regarding configuration files, make sure you

placed your edited files in the /aiw/aiw1/config directory, and continue. The
installer validates the docCustomDefinitions.xml file. The installer does not
verify the correctness of the values in the XML; it uses the schema definition
to check for XML syntax errors.

17. Fix any validation errors and continue the installation.
18. If you see a prompt to activate the installation, select one of these options:

Activate later
Select this option if you have additional feature or extension software
to install.

Activate now
Select this option if this is the last feature or extension that you have
to install.

19. Click Finish to complete the installation. A prompt asks if you have additional
software to install.

20. If you have additional feature or extension software to install, click Yes and
reply to any prompts. Be sure to click Activate now during the final
installation. The primary server restarts as part of the activation.

If you see error messages during the installation process, you can review the logs
located in /opt/IBM/aiw/V1.0/extensions/doc1.

Chapter 3. Installing and activating Manufacturing Optimization 9
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Chapter 4. Configuring Manufacturing Optimization

After installing and activating Manufacturing Optimization, configure it for use.

Customizing document properties for AFP files
You can use Document Property Designer to customize document properties for
AFP files by linking the document properties to index tags. Index tags are also
called Tagged Logical Elements (TLEs). In addition, you can define link options for
the document properties and edit the index tag values.

If you want to manipulate documents using only the standard properties that
Manufacturing Optimization provides–for example, if you want to split a job based
on the number of sheets in each document–you do not need to link custom
document properties to index tags. However, in most cases you will have custom
document properties that you want to use to manipulate documents. For example,
if you have a custom document property representing a postal code and you link it
to its corresponding index tag, then you can sort, split, or group documents by
their postal code.

Linking custom document properties to index tags
You can use InfoPrint Visual Workbench to link document properties to index tags
in a sample AFP file. When a document property is linked to an index tag,
InfoPrint ProcessDirector steps assign the value of the index tag in a production
AFP file to the document property in a workflow. For example, if the value of the
index tag is a ZIP code, the value of the document property is also the ZIP code.

You can link more than one document property to the same index tag. For
example, you might want to link one document property to one portion of an
index tag value and link another document property to another portion of the
same index tag value. For example, an address line might contain both a city and
state or country. If the index tag contains both the city and the country, you can
make separate document properties of City and Country.

You do not need to link all document properties to index tags, and you do not
need to link all index tags to document properties. InfoPrint ProcessDirector
displays the value of an unlinked document property as Not set.

These symbols indicate the status of each document property and index tag:

v The unlinked ( ) symbol indicates the property or index tag is unlinked.

v The linked ( ) symbol indicates the property or index tag is linked.

Before you can link document properties to index tags:
v Work with your InfoPrint ProcessDirector support representative to customize

the /aiw/aiw1/config/docCustomDefinitions.xml and /aiw/aiw1/config/
docCustomDefinitions.properties files for your installation. These files contain
the names of the document properties that you can link to index tags in your
installation.
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v Open a sample AFP file in InfoPrint Visual Workbench. The sample file must
contain page groups and the index tags that you want to link to document
properties. If the AFP Indexer feature is installed, you can use it to create page
groups and index tags.

v As the aiw1 user, create a directory to store the control file containing the links.
InfoPrint recommends the /aiw/aiw1/control_files/workbench directory,
because files in this directory are backed up when you do an aiwbackup process.
This directory and any files you create should be owned by aiw1 or a member
of the aiwgrp1 group, with the same permissions (775) as the control_files
directory.

To link a document property to an index tag:
1. In InfoPrint Visual Workbench, click Mode → Document Property Designer. If

the Document Property Designer mode is the only mode that is available, this
mode is selected automatically.

2. Click Tools → Link Document Properties.
3. In the Link Document Properties window, select a document property and

select the index tag that you want to link to the document property, and then
click Link.

4. Optional: In the Define Link Options window, define the link options for the
document property.

5. Click OK.
6. To link other document properties to index tags, repeat steps 3 to 5.
7. Click OK. You see the document properties and linked index tags listed on the

Document Properties tab in the bottom pane.
8. To save the InfoPrint Visual Workbench control file that contains information

about how the document properties are linked to index tags, do one of these:
v To save a new control file, click File → Save control file as. Select the

directory that you created in step 1 and type the name of the control file in
the File name field, and then click Save. Remember where you saved the
control file because you must specify the location of the control file when
you configure the steps that identify documents in AFP files. The default
extension for control files is .ctl.

v To save an updated control file, click File → Save control file.
v If you used AFP Indexer to define the index tags, you should use the same

control file for the document properties.

Note: When you add a step to the job type, you can reference the control file
name using symbol notation if the name of the control file for the job matches a
value of a job property, such as the job name.

Defining link options for document properties
When you link document properties to index tags, you can define options for each
document property. These options apply to the document property only when it is
linked to the index tag. For example, you can specify whether the index tag is
required, the default value for the document property if the index tag is not found
in a document, and so on. You can also edit the text value for the index tag so that
the document property contains only part of the index tag value.

Before you can define the document property link options, you must link the
document property to an index tag. When you link a document property to an
index tag, Document Property Designer automatically displays the Define Link
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Options window so that you can define the options. If you have previously linked
a document property to an index tag, you can modify the link options.

To define link options for a document property:
1. In InfoPrint Visual Workbench, click Mode → Document Property Designer.
2. Click Tools → Link Document Properties.
3. In the Link Document Properties window, select the document property whose

link options you want to modify and click Modify Link.
4. Optional: In the Define Link Options window, change the index tag that the

document property is linked to by selecting the new index tag from the
drop-down list next to the Linked index tag field.

5. Optional: To edit the text value of the document property, click Edit Value. You
might want to edit the index tag value to remove any leading or trailing
blanks, or to remove unwanted special characters. The edits you make apply
only to the document property value and do not change the value of the index
tag itself.

6. Specify one or more of these fields:

Field Action

Required Select this option if the index tag must exist
in each document. If InfoPrint
ProcessDirector does not find the linked
index tag in a document, the production
AFP job is placed in an error state.

Default value The default value is used if the index tag is
not found in a document. If you did not
select Required, type a default value for the
document property, or select the Not set
option.

Minimum length Select the minimum number of characters (0
- 254) the document property value can
contain. If the index tag value, after it is
edited, is less than the minimum length, the
production AFP job is placed in an error
state. 0, the default, means no minimum
length.

Maximum length Select the maximum number of characters (0
- 254) the document property value can
contain. If the index tag value, after it is
edited, is greater than the maximum length,
the production AFP file is placed in an error
state. 0, the default, means no maximum
length.

Maximum count Select the maximum number of times (0 -
100) the index tag can occur in a document.
If the index tag occurs a greater number of
times, the production AFP job is placed in
an error state. 0, the default, means that the
index tag can occur any number of times
without error.

Chapter 4. Configuring Manufacturing Optimization 13



Field Action

Ignore after nn occurrences Select which index tag in a document (0 -
100) is to be used as the document property
value. For example, if you select 2, the value
of the second index tag in the document is
the document property value. If the index
tag occurs a fewer number of times in a
document, the value of the last occurrence of
the index tag is used. 0, the default, means
that the value of the last index tag in the
document is used as the document property
value.

7. Click OK.

Editing text for index tags linked to document properties
You can edit the text value for an index tag so that the document property contains
only part of the index tag value. You might want to edit the text value to remove
any leading or trailing blanks, or to remove unwanted special characters. The edits
you make apply only to the document property value and do not change the value
of the index tag itself.

For example, if the index tag value contains an account number, 01-345678, you
can edit the text value so that the document property value contains only part of
the account number, such as 345678.

When you edit a text value, make sure that you edit it so that it is appropriate for
all documents because the index tag values can be different in each document.

The editing rules in the table below are applied top to bottom; for example, first
editing by stripping of characters, then editing on delimiters, and finally editing on
characters.

To edit the text value for an index tag that is linked to a document property:
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1. On the Edit Value window, select On for one or more of these fields:

Field Action

Edit by stripping characters Type one character or a blank character (use
the space bar to type a blank character) that
you want to remove from the value. The
character is case-sensitive. Then, select one
of these buttons:

Strip leading characters
The specified character is removed from
the beginning of the value.

For example, if you type a blank
character, all blanks are removed from
the beginning of the value.

Strip trailing characters
The specified character is removed from
the end of the value.

For example, if you type a blank
character, all blanks are removed from
the end of the value.

Strip leading and trailing characters
The specified character is removed from
the beginning and end of the value.

For example, if you type a blank
character, all blanks are removed from
the beginning and end of the value.

Strip all characters
The specified character is removed from
all positions in the value.

For example, an account number is:
324-1443255-11. You can type a - to strip
all - characters from the value,
producing 324144325511.

Edit on delimiter Type a text string of one or more characters
or blanks in the Specify delimiter string
field to indicate where the text value is split
into separate strings. The text is
case-sensitive. Then select numbers for
Select first string and Select number of
strings to mark the beginning and end of
the edited text.

For example, an account number is:
324-1443255-11. You can use - as the
delimiter to split the value into these three
strings: 324, 1443255, and 11. To select the
second and third strings, 1443255-11, select 2
for both Select first string and Select
number of strings.

Edit on character Select numbers for Select first character
position and Select number of characters to
indicate the first character in the text value
and how many characters are included.

When you select the options in the window, the index tag value in the Original
text field is edited based on your selections and the new value is displayed in
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the Edited text field. The index tag value that is displayed is the value of the
first index tag in the first document in the file.

2. Click OK.

Configuring steps to identify documents in AFP files
After you have linked document properties to index tags in a sample AFP file, you
must configure the step that determines values for document properties in
production AFP files. The step names the InfoPrint Visual Workbench control file
that contains information about how document properties are linked to index tags.

Steps that calculate values for document properties are based on the
IdentifyDocuments step template. Some InfoPrint ProcessDirector features provide
job types containing an IdentifyDocuments step. If you use any of those supplied
job types, you can configure the IdentifyDocuments step in the job type to specify
the name of the InfoPrint Visual Workbench control file. These are examples of job
types supplied with InfoPrint ProcessDirector features:
v ReceiveInsert_I (provided with the Inserter feature)
v SortAFP
v SortSplitAFP

If you add an IdentifyDocuments step to another job type, keep these tips in mind:
v The same control file is used for the IndexAFP step, the EditAFP step, and the

IdentifyDocuments step.
v The EnableRepositioning step must precede IdentifyDocuments;

EnableRepositioning updates the AFP file and provides page and sheet
information to the IdentifyDocuments step.

v Place IdentifyDocuments in the Prepare phase and position it after the IndexAFP
step if it is present.

v The IdentifyDocuments step must be after all steps that update the AFP file.

To configure a step that identifies documents in AFP files:
1. On the Main page, click the Administration tab.
2. In the left pane, click Workflow → Job Types.
3. Copy a job type that contains the IdentifyDocuments step.
4. Select the job type that you copied, and click Properties.
5. Select the IdentifyDocuments step in the Prepare phase.
6. If necessary, change the properties for the step in the right side of the window.
7. If you previously linked document properties to index tags, this step is

required. Otherwise, it is optional. In the InfoPrint Visual Workbench control
file field, type the path and file name of the InfoPrint Visual Workbench
control file that contains information about how document properties are
linked to index tags, or use symbol notation to refer to it. InfoPrint Visual
Workbench created this control file when you linked document properties to
index tags. The default extension for control files is .ctl. If you do not specify a
control file, IdentifyDocuments uses any page group information that is
already in the AFP file to identify documents, and no index tags in the AFP
file are mapped to document properties.

8. If the input AFP file does not already contain index tags and you use AFP
Indexer, add the IndexAFP step before the IdentifyDocuments step.

9. Click OK.
10. Select the job type with the IdentifyDocuments step and click Enable.
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Editing the sample document properties template file
The document properties template file determines which properties go into the
document properties file for a job. The template file lets you control the number of
document properties to be used, as well as the order of the columns in the
document properties file. As you create your workflow, look at each step and make
sure that any properties that the step needs are listed in the document properties
template file.

The document properties template file contains the database names of document
properties. Steps based on the ReadDocumentsFromDatabase step template use the
content of the document properties template file to create the document properties
file.

Using a document properties template file is optional, but highly recommended.
Performance is better when the document properties file includes only the
necessary properties. If you do not use it, all document properties are included in
the generated document properties file.

The document properties template file must include all the properties needed by
steps that process the document properties file. In addition, the document
properties template file must include certain properties, depending on the step that
is using the template file. These properties are required by
CreateAFPJobsFromDocuments and BuildAFPFromDocuments:
v Doc.OriginalSheets
v Doc.DataOffset
v Doc.DataLen

These document properties are automatically included in the document properties
file whether or not they are defined in the template:
v Doc.ChildJobID
v Doc.ID (only if you use a step based on the WriteDocumentsToDatabase step

template)
v Doc.OriginalJobID
v Doc.OriginalSequence
v Doc.SequenceInChild

If you have an Inserter feature and you edit the sample document properties
template file, include these Inserter document properties in the template:
v Doc.Insert.Status
v Doc.Insert.Disposition
v Doc.Insert.PendingDisposition
v Doc.Inserter.StatusCode
v Doc.Inserter.StatusCodeExtended
v Doc.Insert.OperatorID
v Doc.Insert.TimeStamp
v Doc.Insert.InserterID
v Doc.Insert.BinTriggers (Inserter Level II feature only)
v Doc.Insert.BinResults
v Doc.Insert.DivertBin
v Doc.Insert.RecipientName
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v Doc.Insert.OriginalBarCode
v Doc.Insert.Sequence
v Doc.Insert.Iteration

You can use more than one document properties template file in one InfoPrint
ProcessDirector system.

To edit a document properties template file:
1. Copy the sample document properties template file named docPropTemplate.txt

from the /opt/IBM/aiw/V1.0/extensions/doc/samples directory to the
/aiw/aiw1/config/ directory. The permissions on the file must allow it to be
readable by aiw1 user.

2. Edit the file to contain the properties that you want to use for step processing
by a specific job type. Keep these tips in mind:
v Add the custom document properties that are important for the job. For

example, if the job type will sort the documents in postal code order, make
sure the Postal Code document property is included in the template file.

v Include only the necessary properties. Limiting the number of properties
improves performance and reduces the amount of storage space needed to
store the document property data.

v All entries in the document property template file must be on a single line;
subsequent lines are ignored.

v Use a space or a tab character between each property.
v A document properties template can also specify job properties.

3. Optional: Create additional document properties template files. For example, if
you create several job types using the PrintDocuments job type, and you want
to manipulate a different set of document properties for each of the new job
types, create a document properties template file for each job type.

Creating step templates and job types
If you have applications that require customized step templates or job types, create
them or edit existing ones to meet your needs. The examples in this section
describe some job types and step templates that you might want to use with
Manufacturing Optimization.

Creating a job type to split jobs by size
Manufacturing Optimization includes step templates that you can use to split a job
into smaller jobs so that, for example, they can be printed on separate printers.

To split a job without fragmenting any of its documents across two jobs, you must
identify the boundaries of the documents in the job. To do that, you must define
page groups in the AFP file, either when you create the job, or by using the
IndexAFP step provided with the AFP Indexer feature of InfoPrint ProcessDirector.

The EnableRepositioning step identifies how the pages are formatted onto sheets,
and the IdentifyDocuments step applies the rules that you defined in Document
Property Designer to create the document property file for the original job. The
SplitDocuments step determines which documents are placed into each child job,
and updates the document properties file with that information.

Now you can choose a method for building the new AFP files for the child jobs:
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v You can use a CreateJobsFromDocuments step, which makes document
properties files for the child jobs but does not create AFP files. In this
implementation, you must include a BuildAFPFromDocuments step in the job
type assigned to the child jobs. BuildAFPFromDocuments creates the AFP file
with all the documents in the correct order. This is the recommended method.
Because BuildAFPFromDocuments is defined in the child job type, it runs in
parallel for all the child jobs. This can cause the overall job to complete faster,
although the existence of several parallel processes might lead to database
contention issues in rare cases.

v You can add a CreateAFPJobsFromDocuments step in the Assemble phase of this
job type. If you choose this method, all the AFP files for all the child jobs are
built sequentially.
This method is not recommended if you have the Inserter feature and the
inserter controller specifies the open-loop reprint method. You must add the
BuildAFPFromDocuments step in the child job type for the open-loop reprint
method; so, adding the CreateAFPJobsFromDocuments step in the original job
type causes duplicate processing, and degrades system performance.

The original job type does not have any steps in the Print phase because the child
job type controls printing. After all the child jobs complete, the parent job enters its
RetainCompletedJobs step, if present, or continues any other processing defined in
the Complete phase of the original job type.

The child job type should begin with steps based on these two step templates:
SetJobProps and SetJobPropsFromOriginal. SetJobProps sets values for job
properties from the steps of the child job type. SetJobPropsFromOriginal copies the
values that were set in the original job type to become the values for those
properties in the child job type. Then if you chose to run the building of the child
AFP files in parallel by including a CreateJobsFromDocuments step in the original
job type, you need to use a BuildAFPFromDocuments step in the child job type.

Table 1. Splitting jobs by size, using CreateJobsFromDocuments

Parent/child Phase Step

Parent Receive SetJobPropsFromRules

In the Input data stream field, select AFP.

Prepare UseInlineFormDefinition

IndexAFP

EnableRepositioning

IdentifyDocuments

Assemble SplitDocuments

CreateJobsFromDocuments

Complete RetainCompletedJobs

RemoveJobs
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Table 1. Splitting jobs by size, using CreateJobsFromDocuments (continued)

Parent/child Phase Step

Child Receive SetJobProps

SetJobPropsFromOriginal

Assemble BuildAFPFromDocuments

Print UseInlineFormDefinition

Needed only if you are using inline form
definitions.

EnableRepositioning

CreatePageRanges

PrintJobs

Complete RetainCompletedJobs

RemoveJobs

Table 2. Splitting jobs by size, using CreateAFPJobsFromDocuments

Parent/child Phase Step

Parent Receive SetJobPropsFromRules

In the Input data stream field, select AFP.

Prepare UseInlineFormDefinition

IndexAFP

EnableRepositioning

IdentifyDocuments

Assemble SplitDocuments

CreateAFPJobsFromDocuments

Complete RetainCompletedJobs

RemoveJobs

Child Receive SetJobProps

SetJobPropsFromOriginal

Print UseInlineFormDefinition

Needed only if you are using inline form
definitions.

EnableRepositioning

CreatePageRanges

PrintJobs

Complete RetainCompletedJobs

RemoveJobs

Adding steps for insertion to job types for splitting jobs
If an Inserter feature is installed, you might want to add steps related to insertion
to the parent and child job types that you created to split jobs.

You must add these steps to the parent job type in the order shown:
v WriteDocumentsToDatabase (Include this step after the IdentifyDocuments step.)
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v CreateJobsFromDocuments (If the job type includes the
CreateAFPJobsFromDocuments step, delete it and use
CreateJobsFromDocuments instead.)

You must add these steps to the child job type in the order shown:
v SetInsertProperties
v BuildAFPFromDocuments
v UseInlineFormDefinition (If no AFP files use inline form definitions, you can

omit this step.)
v WriteInserterControlFile (This step is available only in the Inserter Level II

feature.)
v SendInserterControlFile (This step is available only in the Inserter Level II

feature.)
v InsertJobs
v Reconcile
v CreateInserterReprints

This table shows the steps that you must add to the parent and child job types in
bold text. Your job types might already include the CreateJobsFromDocuments and
BuildAFPFromDocuments steps.

Table 3. Adding steps for inserters to Manufacturing Optimization job types

Parent/child Phase Step

Parent Receive SetJobPropsFromRules

In the Input data stream field, select AFP.

Prepare UseInlineFormDefinition

IndexAFP

EnableRepositioning

IdentifyDocuments

WriteDocumentsToDatabase

Assemble SplitDocuments

CreateJobsFromDocuments

Complete RetainCompletedJobs

RemoveJobs
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Table 3. Adding steps for inserters to Manufacturing Optimization job types (continued)

Parent/child Phase Step

Child Receive SetJobProps

SetJobPropsFromOriginal

Assemble SetInsertProperties

BuildAFPFromDocuments

Print UseInlineFormDefinition

EnableRepositioning

CreatePageRanges

PrintJobs

Insert WriteInserterControlFile (Inserter Level II
feature only)

SendInserterControlFile (Inserter Level II
feature only)

InsertJobs

Reconcile

CreateInserterReprints

Complete RetainCompletedJobs

RemoveJobs

For more information about configuring job types for insertion, see the topics
related to inserters in the information center.

Creating a job type to split jobs by document property
Instead of splitting a job into several jobs using job size as the criterion, you might
want to use the value of a document property, such as country or sales region. In
this scenario, you use the GroupDocuments step template instead of the
SplitDocuments step template. Each group of documents becomes a separate child
job.

You can use a step based on the GroupDocuments step template to gather all the
documents of one group into a single child job. You can use up to six grouping
criteria to create child jobs. Each child job contains only the members of a group,
such as all statements for each of five cities in each of 10 countries.
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Table 4. Splitting jobs by document property, using CreateJobsFromDocuments

Parent/child Phase Step

Parent Receive SetJobPropsFromRules

In the Input data stream field, select AFP.

Prepare UseInlineFormDefinition

IndexAFP

EnableRepositioning

IdentifyDocuments

Assemble GroupDocuments

CreateJobsFromDocuments

Complete RetainCompletedJobs

RemoveJobs

Child Receive SetJobProps

SetJobPropsFromOriginal

Assemble BuildAFPFromDocuments

Print UseInlineFormDefinition

Needed only if you are using inline form
definitions.

EnableRepositioning

CreatePageRanges

PrintJobs

Complete RetainCompletedJobs

RemoveJobs

Table 5. Splitting jobs by document property, using CreateAFPJobsFromDocuments

Parent/child Phase Step

Parent Receive SetJobPropsFromRules

Prepare UseInlineFormDefinition

IndexAFP

EnableRepositioning

IdentifyDocuments

Assemble GroupDocuments

CreateAFPJobsFromDocuments

Complete RetainCompletedJobs

RemoveJobs
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Table 5. Splitting jobs by document property, using
CreateAFPJobsFromDocuments (continued)

Parent/child Phase Step

Child Receive SetJobProps

SetJobPropsFromOriginal

Print UseInlineFormDefinition

Needed only if you are using inline form
definitions.

EnableRepositioning

CreatePageRanges

PrintJobs

Complete RetainCompletedJobs

RemoveJobs

Adding references to medium maps in non-standard AFP files
If you use the Inserter or Manufacturing Optimization feature, InfoPrint
ProcessDirector can use a different medium map to print each document in the file.
(The medium map specifies formatting options, such as duplex options and
overlays.) Your AFP files must contain an Invoke Medium Map (IMM) structured
field in each document (page group) so that InfoPrint ProcessDirector knows
which medium map to use.

The Normalize AFP function that is provided with the Inserter and Manufacturing
Optimization features can add IMM structured fields in each document in a job if
they do not already exist. To use the Normalize AFP function, you create a step
(based on the RunExternalProgram step template) that runs the afpnorm
command. Then, you include this step in your job types before the
IdentifyDocuments step.

To create a step that adds references to medium maps:
1. Copy the RunExternalProgram step template, giving it a unique name such as

NormalizeAFP.
2. In the External command field, type this command exactly as shown here:

afpnorm -m -o ${getFileName(print,afp,write)} -f
"${Job.Line2AFP.FORMDEF}" -p "${Job.Print.ResourcePath}"
${getFileName(print,afp,read)}

3. Delete the content in the External control file property.
4. Save the step.
5. Tune the step so that it runs only on the primary server.
6. Add the new step into your job type, inserting it:
v After IndexAFP (if applicable)
v Before EnableRepositioning
v Before IdentifyDocuments
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Creating the Enhance AFP control file
You can create an Enhance AFP control file to define where to place AFP data on a
page. For example, you can apply bar codes, mask text by creating hidden areas
(cover blocks), or add text.

The BuildAFPFromDocuments and CreateAFPJobsFromDocuments step templates
can make enhancements to AFP files. When you set up steps based on these step
templates, you enter the location of the Enhance AFP control file to be used in
manipulating the AFP data.

Documentation and examples for using Enhance AFP are located on the product
CD in the /samples directory. After installation, you can find them in the directory
/opt/IBM/aiw/V1.0/extensions/doc/samples/.
1. As the aiw1 user, create a directory to store the Enhance AFP control file.

InfoPrint recommends the /aiw/aiw1/control_files/enhanceafp directory,
because files in this directory are backed up when you do an aiwbackup
process. This directory should be owned by aiw1 or a member of the aiwgrp1
group, with the same permissions (775) as the control_files directory.

2. Create an Enhance AFP file that defines setup attributes and update requests.
Documentation and examples for using Enhance AFP are located on the
product CD in the /samples directory and the /publications directory.

3. Save the file in the directory that you created in step 1.

Specify the path to this file in the Enhance AFP control file property of the step in
the Assemble phase, in the job type that creates the AFP file.
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Chapter 5. Reactivating Manufacturing Optimization

If you change the docCustomDefinitions.xml file, you must reactivate InfoPrint
ProcessDirector and Manufacturing Optimization.

Before doing this task, verify that the syntax in the docCustomDefinitions.xml file
is correct. You can use xmllint to validate the file.

To reactivate Manufacturing Optimization:
1. Log in to the operating system as the aiw1 user.
2. Enter this command to stop the server:

stopaiw

3. Log in as the root user.
4. Navigate to the /opt/IBM/aiw/V1.0/base/ directory.
5. Enter this command to start the activation process:

./activate.sh

If you see error messages during the activation process, you can review the
logs located in /opt/IBM/aiw/V1.0/extensions/doc1 directory.

6. Log in as the aiw1 user.
7. Enter this command to restart the server:

startaiw
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Chapter 6. Reference

This section includes format information and examples of configuration files.

Installation and configuration checklist
This checklist can help you plan your installation and configuration process.

Task Notes

Decide which document properties
you want to use for all the
applications that you process.

Define custom document properties
in the document properties
configuration file
(docCustomDefinitions.xml).

Edit the associated
docCustomDefinitions.properties file.

Run the installer.

Use InfoPrint Visual Workbench
Document Property Designer to link
custom document properties to index
tags.

Edit the sample document property
template file.

Create or edit step templates and job
types as needed.

Optional: Create the Enhance AFP
control file.

AFP data standards and requirements
The AFP data standard for Manufacturing Optimization and Inserter defines
general characteristics of AFP print data.
v Each document in an AFP file must be bounded by Begin Named Group (BNG)

and End Named Group (ENG) structured fields.
v Each document in an AFP file must use one or more Tagged Logical Element

(TLE) structured fields to identify the document and its properties. These are
often called index tags.

v The AFP file must conform to certain formatting rules so that text, bar code, and
cover block enhancements can be added to its documents.

v AFP resources including fonts, form definitions, page segments, and overlays
must be included as an inline resource group or as external files in the resource
path. External resource groups are not supported.
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AFP data stream preparation
You can prepare the AFP data stream to conform to the standard before it reaches
InfoPrint ProcessDirector, or prepare the data in InfoPrint ProcessDirector. You do
not need to prepare the data at all if document-level processing is not required. To
prepare the data in InfoPrint ProcessDirector, you use AFP Indexer and other
utility programs.

The degree of preparation done before the AFP file is submitted to InfoPrint
ProcessDirector as a job determines how much processing InfoPrint ProcessDirector
might need to do. You add different steps to your job types depending on the
amount of processing that you want InfoPrint ProcessDirector to do.

Standardized AFP requirements
Standardized AFP is the required input for document tracking and manipulation.
This topic describes document delineation, document indexing, and document
manipulation requirements.

Document delineation

Begin Named Group (BNG) and End Named Group (ENG) structured fields
surround each document in the AFP file.

Each page contained by the group delimiters is included; therefore, banners or
separator pages that are not to be enclosed in an envelope should not be included
in the group. Pages outside the groups at the beginning and end of the file or
between groups through the file are discarded before printing, because each
document becomes a unique entity that is no longer required to remain with the
other documents in the print file.

This standard applies to each document, whether or not the document is ever
physically printed or mailed.

Document indexing

Each document includes at least one Tagged Logical Element (TLE) structured field
that lets an operator easily identify the document. In the Inserter features, this is
defined as the Mailpiece Recipient. With the Manufacturing Optimization feature,
you can specify additional document properties that contain values from the index
tags in the data.

Documents that the Inserter feature processes must include a TLE that contains
information the inserter can use to determine what inserts to include with each
document.

Documents that are to be sorted or grouped using Manufacturing Optimization
need TLEs to define the grouping and sorting criteria. Typically these include
postal (ZIP) code and mail type (foreign, courier, and so on). Some criteria can be
defined in job properties instead of in individual document TLEs.

This is a sample of standard AFP structure:
BDT (Begin Document)

BPG (Begin Page – Header page (s)
EPG (End Page)
BNG (Begin Named Group – Document)
IMM
TLE (Tagged Logical Element) – CustomerAcctNo
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TLE (Tagged Logical Element) – CustomerAddr<1-6>
TLE (Tagged Logical Element) – MailRecipient
TLE (Tagged Logical Element) – CustomerZIP
TLE (Tagged Logical Element) - CustomerInsertBins
BPG (Begin Page)
Page data
EPG (End Page)
BPG (Begin Page)
Page data
EPG (End Page)
ENG (End Named Group)
EDT (End Document)

Document manipulation

The AFP file must adhere to the formatting rules listed here to allow the addition
of text, bar codes, or cover blocks. Those additions can be made with the Enhance
AFP control file that is specified on the CreateAFPJobsFromDocuments and
BuildAFPFromDocuments step templates. These rules are in addition to the
document indexing rules and define a consistent set of documents throughout the
file.

Requirements and Examples

Valid AFP
The AFP data must conform to the Data Stream and Object Architecture:
MO:DCA Reference.

BDT/EDT(s)
The AFP data can contain more than one pair of Begin Document (BDT)
and End Document (EDT) structured fields, but they cannot be nested.
Example:
BDT
...
EDT
BDT
...
EDT

Named Groups - BNG/ENG(s)
Named page groups for document boundaries must be present. If there are
nested page groups, only the outer level is used to define document
boundaries.
Example: 2 mailpieces
BNG (1st mailpiece)
BNG/../ENG (nesting allowed)
BNG/../ENG\
ENG
BNG (2nd mailpiece)
ENG

Pages - BPG/EPG(s)
Pages outside of named groups are ignored. These pages are not indexed
or printed.
Example: 2 banner pages
BDT
BPG/EPG (discarded)
BPG/EPG (discarded)
BNG
BPG/EPG (1st document)
ENG
EDT
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Index Tags - TLE(s)
Index tags cannot occur outside of existing named page group boundaries.
One instance of each required index tag is found in the bounds of the
named group. These index tags can be in nested named groups or pages.

There is only one value for each required index tag, regardless of how
many TLEs of the same name have been provided. Therefore, multiples of
the same index tag, such as CustomerName in a group, are not supported.
Example: valid TLEs
BDT
BNG
TLE 1
BPG
TLE 2
EPG
TLE 3
ENG

Invoke Medium Maps - IMM(s)
An Invoke Medium Map structured field must be included after the BNG
structured field that marks the beginning of each document, and before the
first BPG structured field that marks the beginning of the first page of the
document.
Example:
BDT
BNG/IMM/../ENG
BNG/IMM/../ENG
BNG/IMM/../ENG
...
EDT

Units Measurement units in any Presentation Text Descriptor (PTD) structured
field in the document must match the units set in the Page Descriptor
(PGD) structured field.

Enhanced N-Up
The form definition used for the AFP data can use the enhanced N-up
function but it cannot specify pagination between the partitions.

Constant Pages
If the constant pages function of the form definition is used, it must specify
only constant pages that fit a consistent pattern, such as all backs, all
fronts, first back of each document, and so on.

Mixed Plex
The form definition used for the AFP data must not change back and forth
between simplex and duplex.

Form definition functions
The form definition must not contain these structured fields: Presentation
Finishing Control (PFC), Map Suppression (MSU), and Medium Finishing
Control (MFC).

Indexable AFP requirements
The basic requirement for indexable AFP is that AFP Indexer can be used to
establish document boundaries and to add index tags to form standardized AFP.
Note that AFP Indexer only does document delineation and document indexing. It
does not change AFP data to conform to the document manipulation requirements
of standardized AFP, such as including an inline medium map inside each
document.
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Begin Named Group (BNG) and End Named Group (ENG) structured fields that
already exist in the input AFP data can be either recognized and retained by AFP
Indexer, or removed and replaced using AFP Indexer to define a new document
trigger.

If existing named page groups are retained, the levels of nesting to be retained can
be selected during configuration. The system determines documents based on the
outermost named page groups.

When named page groups are preserved, existing index tags (TLEs) can also be
preserved.

This section describes the requirements of the AFP data to be input to AFP Indexer.

Requirements and Examples

Valid AFP
The AFP data must conform to the Data Stream and Object Architecture:
MO:DCA Reference.

BDT/EDT(s)
The AFP data can contain more than one pair of Begin Document (BDT)
and End Document (EDT) structured fields, but they cannot be nested.
Example:
BDT
...
EDT
BDT
...
EDT

Pages – BPG/EPG(s)
Pages before the start of named groups are not indexed.
Example: 2 banner pages discarded
BDT
BPG/EPG
BPG/EPG
BNG
BPG/EPG (1st document)
ENG
...
EDT

Existing Named Page Groups – BNG/ENG(s)
Named page groups for document boundaries can be present. The nesting
level is specified when you select to keep the existing named page groups.

You can remove named page groups and redefine boundaries by setting a
new document trigger.

Existing TLEs are removed if the document trigger is redefined.
Example: 2 documents
BNG (1st document)
BNG/../ENG (nesting allowed)
BNG/../ENG\
ENG
BNG (2nd document)
ENG

Existing Indexes – TLE(s)
Existing index tags can be retained if named page groups are maintained.
Index tags cannot occur outside of existing named page group boundaries.
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Document Triggers
To add named page groups for document delineation, you must define a
document trigger.

The AFP text field must be in a constant physical (print) location, in the
same sequence in the case of multiple fields in that location.

If parsing is required, the parsing rules must apply consistently to the
document trigger text for every document in the file.

Only Presentation Text Object Content Architecture (PTOCA) within an
AFP page is supported. AFP Image, Draw Rules, Bar Code Object Content
Architecture™ (BCOCA™) objects, or PTOCA in page segments or overlays
are not supported as document triggers.
Sample document trigger:
BPG
PTX
TRN (full trigger text)

EPG

Index tags
The AFP text must be in a constant physical (print) location or area, and in
the same sequence in the case of multiple text blocks in that location.

If parsing is required, the parsing rules must apply consistently to the
index data for every document in the file.

Only Presentation Text data within an AFP page is supported for use as an
index tag. AFP Image, Draw Rules, BCOCA objects, or PTOCA in page
segments or overlays are not supported as index tag data.

Sample index tag:
BPG
PTX
TRN (index text here)

BPG

docCustomDefinitions.xml file

The document properties configuration file (docCustomDefinitions.xml) defines
properties that are used to manage documents and jobs. A sample file is located in
the /samples directory on the service update CD. The activation process places a
sample in /opt/IBM/aiw/V1.0/extensions/doc/samples.

The sample docCustomDefinitions.xml file contains several sections. This table
summarizes the sections in the file.

Table 6. Sections in the docCustomDefinitions.xml file

Section Purpose

Schema The schema section identifies the schema and the unique character
string for the custom document properties. Only the InfoPrint support
representative should edit this section.
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Table 6. Sections in the docCustomDefinitions.xml file (continued)

Section Purpose

Database
properties

The values of database properties are displayed in the user interface; the
values of limited properties are not displayed. The most common
reasons to use database properties rather than limited properties are:

v To view document property values in the user interface.

v To search for a document based on a particular property value. For
example, if you have the Inserter feature and you want to use a
custom document property to search for documents to reconcile or to
reprint, the document property must be a database property.

Database property manipulation can degrade performance if you are
processing a significant number of documents. Work with your InfoPrint
support representative to determine your specific needs.

If you have the Document Pool extension, you can use selectors to
manipulate documents based on their property values if the properties
are defined as database properties.

Limited
properties

You can include document properties and job properties in this section
of the file. Limited properties can be manipulated in a document
properties file, but they are not stored in the database and their values
do not display in the user interface. Property names do display in the
user interface where applicable; for example, in the SortDocuments step,
document property names display in drop-down lists.

Common reasons to use limited properties rather than database
properties are:

v To avoid displaying sensitive property values in the user interface,
such as Social Security numbers or check amounts

v To maximize performance

Work with your InfoPrint support representative to determine your
specific needs.

If you specify job properties here, you can use them for sorting or
grouping, and they are added to the document properties file.

User
authorization
properties

This section is optional. User authorization properties specify custom
authority groups for access to database properties.

Schema section

The Schema section contains one docCustomDefinitions element and one schema
element. Only InfoPrint support representatives should edit the schema section.

Database properties section

The Database properties section contains the docProperty element.

Database properties and limited properties can be:
v Stored in a document properties file
v Used with steps in a job type to group or sort documents (for example, with the

SortDocuments step template)
v Linked to index tags using the InfoPrint Visual Workbench Document Property

Designer
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Note: Do not define a property as both a database property and a limited
property. Unexpected behavior might occur.

<docProperty>
Defines document properties that are in the database.

Note: Do not define a property as both a database property and a limited
property. Unexpected behavior might occur.

Table 7. Attributes for the docProperty element

docProperty attribute Required? Notes

name Yes The internal name of the property used by
programs that read or write properties.
InfoPrint recommends that you use a
consistent naming convention for your
custom property names, so they are unique
across the entire system. For example, the
sample docCustomDefinitions.xml file uses
the prefix Doc.Custom to make its properties
unique from those of InfoPrint
ProcessDirector.

access No The user access level for the property. You
can use an access level that is already
defined in Manufacturing Optimization, or
you can create a custom access level if an
existing one does not meet your needs. See
the Access section for more information.

datatype Yes The InfoPrint ProcessDirector data type to
use for the property. See the next table.

dbType Yes A database parameter that specifies the type
of data. See the next table.

caption Yes The default caption displayed in the user
interface for the property. If you are setting
up captions in only one language, define
them in this file. If you are setting up
captions in more than one language, create
additional document properties names files
(docCustomDefinitions_language.properties)
for the other languages. See the related
information center topic for details.

shortCaption Yes The default short caption displayed for this
property where required, such as in table
column headings. If you are setting up short
captions in only one language, define them
in this file. If you are setting up short
captions in more than one language, create
additional document properties names files
(docCustomDefinitions_language.properties)
for the other languages. See the related
information center topic for details.
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Table 7. Attributes for the docProperty element (continued)

docProperty attribute Required? Notes

description Yes The default description of the document
property, which displays in the user interface
as help text. If you are setting up
descriptions in only one language, define
them in this file. If you are setting up
descriptions in more than one language,
create additional document properties names
files
(docCustomDefinitions_language.properties)
for the other languages. See the related
information center topic for details.

You can use these data types and database types in database property
definitions. Keep in mind that the database definition might further restrict the
values that can be stored, in addition to the validation rules shown in this
table. For example, a SMALLINT can store integers from 0 to 32,767 and a
VARCHAR(12) does not permit strings longer than 12 characters. Database
type values are not case-sensitive.

Table 8. Data types and database types for docProperty definitions

Data type
Database type (used
in SQL) Validation for data type

String CHAR
VARCHAR
LONG VARCHAR

CHAR: fixed length, 1–254 characters
VARCHAR: variable length, 1–32,672

characters
LONG VARCHAR: variable length,

1–32,700 characters

IntegerNonNeg SMALLINT
BIGINT
INTEGER

SMALLINT: 2 bytes
BIGINT: 4 bytes
INTEGER: 8 bytes
Minimum=0

Limited properties section

The Limited properties section contains one or more docProperty or jobProperty
elements.

Database properties and limited properties can be:
v Stored in a document properties file
v Used with steps in a job type to group or sort documents (for example, with the

SortDocuments step template)
v Linked to index tags using the InfoPrint Visual Workbench Document Property

Designer

Note: Do not define a property as both a database property and a limited
property. Unexpected behavior might occur.

<docProperty>
Defines document properties that are manipulated only in the document
properties file and not in the database.
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Table 9. Attributes for the docProperty element

docProperty attribute Required? Notes

name Yes InfoPrint recommends that you use a
consistent naming convention for your
custom property names, so that they are
unique across the entire system. For
example, the sample
docCustomDefinitions.xml file uses the
prefix Doc.Custom to make its properties
unique from InfoPrint ProcessDirector.

datatype No See the next table.

caption No The caption displayed in drop-down lists in
the user interface for this property. If you are
setting up captions in only one language,
define them in this file. If you are setting up
captions in more than one language, create a
document properties names file
(docCustomDefinitions_language.properties)
for the other languages. See the related
information center topic for details.

You can use these data types in docProperty definitions:

Table 10. Data types for the docProperty element

Data type Validation for data type

String None

IntegerNonNeg Integer between 0 and 2147483647

<jobProperty>
Lets you write job properties to the document properties file. If you specify job
properties, you can use them for sorting or grouping. The only valid attribute
for job properties is name. You must define job property captions in the
document property names file (docCustomDefinitions.properties). Job property
captions display in drop-down lists in the user interface, where applicable.

Table 11. Attribute for the jobProperty element

jobProperty attribute Required? Notes

name Yes Job properties come from a document’s
original job. This is only a reference to an
existing job property, not a definition.

Automatically defined document properties

These properties are not defined in docCustomDefinitions.xml but they are
automatically stored in the document database. Do not add them to the
docCustomDefinitions.xml file:
v Doc.ID
v Doc.OriginalJobID
v Doc.OriginalSequence
v Doc.OriginalSheets
v Doc.OriginalPages
v Doc.OriginalFirstPage
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v Doc.State

docCustomDefinitions.properties file

The entries in the docCustomDefinitions.properties file are used in the InfoPrint
ProcessDirector user interface when you select document or job properties from
lists, in online help, and in messages. A sample file is in the /samples directory on
the service update CD, and the activation process places a sample file in
/opt/IBM/aiw/V1.0/extensions/doc/samples.

Entries in the docCustomDefinitions.properties file are related to the docProperty
and jobProperty elements in the docCustomDefinitions.xml file. The
docCustomDefinitions.properties file is required to:
v Define captions for any job properties that you defined in the

docCustomDefinitions.xml file. Job property captions cannot be defined in the
docCustomDefinitions.xml file.

v Define captions, short captions, and descriptions if you are setting up more than
one language. You create a separate docCustomDefinitions_language.properties
file for each additional language.

When creating language-specific docCustomDefinitions_language.properties files,
use a language identifier in each file name. For example:
v docCustomDefinitions_de.properties (German)
v docCustomDefinitions_en.properties (English)
v docCustomDefinitions_es.properties (Spanish)
v docCustomDefinitions_fr.properties (French)
v docCustomDefinitions_it.properties (Italian)
v docCustomDefinitions_ja.properties (Japanese)
v docCustomDefinitions_pt.properties (Brazilian Portuguese)
v docCustomDefinitions_ru.properties (Russian)
v docCustomDefinitions_zh.properties (Traditional Chinese)
v docCustomDefinitions_tw.properties (Simplified Chinese)

You create a stanza of short caption, caption, document field, and description
values for every document property. For job properties, only the document field
element is applicable.

[property].Short
A shortened form of the property name. This value appears as the column
heading in the user interface.

[property]
The full property name.

DocumentField.[property]
Drop-down lists and captions in the user interface.

[property].Description
A description of the property. Use HTML tags if you want to format the
text. This content appears in the online help when the user clicks the Help
icon.

For example:
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Doc.Custom.Zip.Short=ZIP
Doc.Custom.Zip=ZIP code
DocumentField.Doc.Custom.Zip=ZIP code
Doc.Custom.Zip.Description=The ZIP code of an address

DocumentField.Job.Class=Job class

Note:

Do not rename the default docCustomDefinitions.properties file; a file with this
name must exist in your configuration directory (/aiw/aiw1/config). Copy the file
and name the copy with the appropriate language identifiers as needed.

Document properties template file
The document properties template file determines which properties go into the
document properties file for each job. The template file lets you control the number
of document properties to be used, as well as the order of the columns in the
document properties file. As you create your workflow, look at each step and make
sure that any properties that the step will need are listed in the document
properties template file. A sample file is located on the product CD in the
/samples directory. After installation, you can find it in the directory
/opt/IBM/aiw/V1.0/extensions/doc/samples/.

The document properties template file contains a single line that lists the database
names of document properties separated by a tab or space character. When a step
based on the ReadDocumentsFromDatabase step template creates the document
properties file, it copies the first line from the template file. Then the step creates a
separate line for each document associated with the job. Each document
description line lists the property values, separated by a tab or space character, in
the same order that they appear in the first line. If a value is Not set, an empty
string (’’) is placed in the file.

Using a document properties template file is optional, but highly recommended. If
you do not use it, all document properties are included in the generated document
properties file. For best system performance, use a template so that the step
includes only the necessary properties.

The document properties template file must include all the properties needed by
steps that process the document properties file. In addition, the document
properties template file must include certain properties, depending on the step that
is using the template file. These properties are required by
CreateAFPJobsFromDocuments and BuildAFPFromDocuments:
v Doc.ChildJobID (*)
v Doc.OriginalJobID (*)
v Doc.OriginalSequence (*)
v Doc.SequenceInChild (*)
v Doc.OriginalSheets
v Doc.DataOffset
v Doc.DataLen

Document properties marked with an asterisk (*), as well as the Doc.ID property,
are automatically included in the document properties file whether or not they are
defined in the template:
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A document properties template can also specify job properties.

Document properties file
Manufacturing Optimization uses information from the document properties file in
these processes:
v Steps that process documents, such as steps based on the

CreateAFPJobsFromDocuments and BuildAFPFromDocuments step templates.
For either the CreateAFPJobsFromDocuments or BuildAFPFromDocuments steps
to run successfully, these properties must be included in the document
properties file:
– Doc.OriginalJobID
– Doc.ChildJobId
– Doc.SequenceInChild
– Doc.OriginalSequence
– Doc.OriginalSheets
– Doc.DataOffset
– Doc.DataLen

v Steps that sort, group, and split documents into AFP files. For example, if you
want to use a step to sort documents by ZIP code, a property such as
Doc.Custom.ZipCode must be in the document properties file.

v External programs that process document properties.

The first line in the document properties file contains the information from the
document property template file. Each additional line contains values for each of
the properties from one document.

The document properties file is created automatically.
v If you use a step based on the IdentifyDocuments step template, the step creates

the document properties file using the InfoPrint Visual Workbench control file as
a guide.

v If you use a step based on the ReadDocumentsFromDatabase step template, the
step creates the document properties file using a document property template
file as a guide.

v If you use a step based on the CreateJobsFromDocuments or
CreateAFPJobsFromDocuments step template, the step creates the document
properties file for child jobs using the document properties file of the parent
(current) job as a guide.

The GroupDocuments, SortDocuments, and SplitDocuments steps of the Assemble
phase can manipulate the document properties file. The document properties file
might also be used by an external program or a custom step that you create.

A document properties file always contains the properties Doc.ChildJobId and
Doc.SequenceInChild. If a step (such as GroupDocuments) that creates document
groups runs, the document properties file will contain more than one value for
Doc.ChildJobId.

The document properties file is stored in the job’s spool directory and has the
format jobid.document.dpf (for example, /aiw/aiw1/spool/default/10000009/
10000009.document.dpf). The values are in UTF-8 format and separated by tabs.

Chapter 6. Reference 41



Some information in the document properties file is not stored in the database but
is used only during the processing of steps. This information, for example, is in the
document properties file but not in the database:

Doc.DataOffset
The offset of the print data for the document in the original job’s print file.

Doc.DataLen
The length of the print data for the document in the original job’s print
file.

Document property conditions file
Steps based on the SetDocPropsFromConditions step template set document
properties in the current job based on conditions found in this property conditions
file. The document property conditions file is a comma-separated value (CSV) file.
The path to a sample document property conditions file is /aiw/aiw1/doc/
DocPropConditions.csv.

The first line in the file lists names of the document properties; first the properties
that are part of the conditions, and then the properties that this step sets if the
conditions are all true. Each remaining line in the file represents an if-then
conditional statement. When all of the conditions on that line are true, all of the
specified values are set. If any of the conditions is not true, none of the specified
values are set.

This is an example of a document property conditions file.
Doc.Custom.MailCategory,Job.Name,Doc.Run.PAVE
=USPS,Yes
=USPS,~XYZ*,No
=NonUSPS,No
=Exception, No

The first if-then condition sets a default that if a mailpiece category is USPS,
InfoPrint ProcessDirector sets the Doc.Run.PAVE property to Yes. The second line
overrides the default if the job name begins with XYZ.

We recommend that you place all properties that are part of conditions to the left
of properties that are receiving values. Properties that are part of conditions use
condition characters from this set:

Table 12. Condition characters in the conditions file

Condition characters Condition Example

=[value] equal to =Fir

<>[value] not equal to <>Fir

<[value] less than <4900000

>[value] greater than >61000

<=[value] less than or equal to <=61207

>=[value] greater than or equal to >=61207

~[value] like ~INSURE*.AFP

!~[value] not like !~*.AFP

″([val1],[val2],...)″ in (must start and end with
parentheses surrounded by
quotation marks)

″(PRTA, PRTB)″
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Table 12. Condition characters in the conditions file (continued)

Condition characters Condition Example

!″([val1],[val2],...)″ not in (must start and end
with parentheses surrounded
by quotation marks)

!″(PRTA, PRTB)″

“ (blank) wildcard (*)

Usage notes
v You can use InfoPrint ProcessDirector symbol notation in the conditions file to

set conditions based on the current value of a particular document or job
property. See the related Reference topic for a description of symbol notation
syntax.

v You can begin a line in the conditions file with the exclamation point character
(!) if you want to set a condition to update the document properties file, but not
to update the database. For example, you might want to update a job property
in the document properties file, but not on the job, when setting the job type for
child jobs produced by CreateJobsFromDocuments or
CreateAFPJobsFromDocuments. The default value for the child job type is the
property of the job, but the document properties file can override the value. The
conditions file can set the child job type for documents in the document
properties file, and can use the ! character to prevent the job’s property from
being changed.

v Spaces can separate keyword characters from condition values.
v The ? and * characters are wildcard characters used with the like and not like

conditions. The question mark matches single characters and the asterisk
matches any number of characters.

v If a condition field has an equal sign (=) without a value, the condition is true if
the job’s property value is null. If a field has an empty value, the property is
ignored for that line; it is not part of any condition and its value is not changed.
Because of this rule, the step cannot set a job property to null.

v Each line is evaluated independently.
v All lines with conditions that match a document’s properties are applied to the

document. The lines are applied in the order that they occur in the file.
v Leading and trailing blanks are removed from field values before any

comparison or set operation takes place. Blanks within a value (not leading or
trailing) are retained.

Enhance AFP control file
Steps based on the BuildAFPFromDocuments and CreateAFPJobsFromDocuments
step templates use an Enhance AFP control file to change the content of AFP files.
You can work with your InfoPrint support representative to create control files that
contain rules for the changes. Documentation and examples for using Enhance AFP
are located on the product CD in the /samples directory. After installation, you can
find them in the directory /opt/IBM/aiw/V1.0/extensions/doc/samples/.

These are examples of the changes you can make using Enhance AFP:
v Insert new bar codes or text.
v Remove obsolete content, such as bar codes, text, or OMR marks.
v Find variable text or bar code content to use as a basis for generating new

content.

Chapter 6. Reference 43

|
|
|
|

|
|
|
|
|
|
|
|
|
|

|
|
|



v Insert, find, or remove index tags (TLEs).

Messages and some of the instructions related to Enhance AFP refer to the function
as adf_extract.

Visit the InfoPrint Solutions Company Web site to see the most recent version of
the documentation:

http://www.infoprint.com/infocenter
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Appendix. Accessibility

InfoPrint Solutions Company strives to provide products with usable access for
everyone, regardless of age or ability. For more information about the commitment
that we have made to accessibility, see: http://www.infoprint.com/accessibility

Accessibility features

Accessibility features help users who have disabilities, such as restricted mobility
or limited vision, use information technology products successfully.

The major accessibility features in this product let you:
v Use screen readers, screen magnifiers, and other assistive technologies.
v Use a keyboard instead of a mouse.
v Change attributes such as volume, color, contrast, and font size.
v Distinguish keys by touch without activating them.
v Attach alternative input and output devices such as special pointing devices and

Braille displays.

In addition, the information center and the publications for the product are in an
accessible format.

Keyboard navigation

This product uses standard Microsoft® Windows® navigation keys.
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Notices

This information was developed for products and services offered in the U.S.A.

InfoPrint Solutions Company may not offer the products, services, or features
discussed in this document in other countries. Consult your local InfoPrint
Solutions Company representative for information on the products and services
currently available in your area. Any reference to an InfoPrint Solutions Company
product, program, or service is not intended to state or imply that only that
InfoPrint Solutions Company product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any
InfoPrint Solutions Company intellectual property rights may be used instead.
However, it is the user’s responsibility to evaluate and verify the operation of any
non-InfoPrint Solutions Company product, program, or service.

References in this document to InfoPrint Solutions Company products, product
features, programs or services do not imply that InfoPrint Solutions Company
intends to make such products, product features, programs or services available in
all countries in which InfoPrint Solutions Company operates or does business.

InfoPrint Solutions Company may have patents or pending patent applications
covering subject matter described in this document. The furnishing of this
document does not give you any license to these patents. You can send license
inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
InfoPrint Solutions Company Intellectual Property Department in your country or
send inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INFOPRINT
SOLUTIONS COMPANY PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. InfoPrint Solutions Company may
make improvements and/or changes in the product(s) described in this publication
at any time without notice.
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Any references in this information to non-InfoPrint Solutions Company Web sites
are provided for convenience only and do not in any manner serve as an
endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this InfoPrint Solutions Company product and use of those Web
sites is at your own risk.

InfoPrint Solutions Company may use or distribute any of the information you
supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by InfoPrint Solutions Company under terms of the
InfoPrint Solutions Company Customer Agreement, InfoPrint Solutions Company
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-InfoPrint Solutions Company products was obtained
from the suppliers of those products, their published announcements or other
publicly available sources. InfoPrint Solutions Company has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-InfoPrint Solutions Company products. Questions on
the capabilities of non-InfoPrint Solutions Company products should be addressed
to the suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
These terms are trademarks or registered trademarks of Ricoh Co., Ltd., in the
United States, other countries, or both:
v Advanced Function Presentation
v AFP
v Bar Code Object Content Architecture
v BCOCA
v InfoPrint
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v MO:DCA
v Ricoh

These terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both:
v AIX
v IBM

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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